# Table of Contents

## Chapter 1: Installing Avalanche
- Installation Prerequisites .............................................. 3
  - Before You Begin (PostgreSQL) .................................. 4
  - Before You Begin (Oracle) ....................................... 4
- Installing with RPM Files .......................................... 5
- Populating the Databases ........................................... 6
- Configuring the Database and Tomcat Files ...................... 10
- Extracting the WAR File for Tomcat .............................. 13
- Starting the Services .................................................. 14
- Increasing the Open Files Limit .................................... 14

## Chapter 2: Deploying a Mobile Device Server
- Creating a Server Location .......................................... 16
- Importing the RPM Files ............................................. 16
- Building an RPM Deployment Package ............................ 17
- Configuring Serial and USB Support .............................. 18

## Chapter 3: Using the Package Converter
- Requirements .................................................................. 20
- Converting Packages .................................................... 20

## Appendix A: Installing with tar Files
- Creating Server Directories ........................................... 22
- Installing the Servers ..................................................... 23
  - Installing the Enterprise Server ................................. 23
  - Installing the Statistics Server ................................. 23
  - Installing the InfoRail Service ................................. 24
  - Installing the License Server ................................. 24
  - Installing the Mobile Device Server ......................... 24
  - Installing the Service Manager ................................. 25
- Configuring the Databases and Tomcat ........................... 25
- Starting the Servers ..................................................... 25
- Configuring the Mobile Device Server after Manual Installation .... 27
  - Configuring with editconfig.pl ................................. 27
  - Configuring the Properties Files ............................. 27
- Managing the Mobile Device Server from the Console ........ 28

## Appendix B: Wavelink Contact Information
- ................................................................................. 30
Chapter 1: Installing Avalanche

You can install and manage many of the components of Avalanche MC on a Linux operating system. This includes the Enterprise Server, Statistics Server, Mobile Device Server, License Server, Service Manager, and InfoRail. These components can be installed using RPMs, tar files, or the Mobile Device Server can be deployed from the Avalanche Console after installing the other components.

**NOTE** The Avalanche Java Console and any Infrastructure Servers must be installed on a Windows operating system. Refer to the *Avalanche 5.2 System Requirements* paper on the Wavelink Web site for details on system requirements.

In addition to the Avalanche files provided by Wavelink, you will also need to acquire and install a JRE, Apache Tomcat, and a database management system (DBMS). More information on these is available in the *Installation Prerequisites* on page 3.

Perform the following steps in order to ensure the Avalanche servers are correctly installed on a Linux operating system:

1. Verify that installation requirements are met and that the JRE and Tomcat are installed. You should also have the database management system installed and the Before You Begin tasks completed.

2. Set user permissions to allow the user to execute scripts and commands for each server. The user should be set to *not require TTY*.

3. Ensure that traffic between components will not be blocked by firewalls. For information on what ports need to be open to allow Avalanche traffic, see the Ports list in the Avalanche MC User Guide.

4. Obtain the installation files and install the Avalanche components.

5. Populate and configure the databases and extract the WAR file.

6. Start the servers.

7. If necessary, increase the open files limit for the InfoRail server.

8. Install the Avalanche Java Console on a Windows computer.

9. Launch the Avalanche Java Console and use it to deploy any Mobile Device Server RPMs.
Chapter 1: Installing Avalanche

The following sections provide details on how to install Avalanche on Linux:

- Installation Prerequisites
- Installing with RPM Files
- Populating the Databases
- Configuring the Database and Tomcat Files
- Extracting the WAR File for Tomcat
- Starting the Services
- Increasing the Open Files Limit

**Installation Prerequisites**

For system requirements, see the *Avalanche 5.2 System Requirements* paper on the Wavelink Web site.

The following minimum specifications are required before you install the servers on Linux:

- Java Runtime Environment (JRE) 1.6.24 or newer. The JRE is required by the Enterprise and Statistics Servers, License Server, InfoRail, Tomcat, and the DBMS.
- Sufficient rights to install programs and create and maintain the Avalanche Server working directory.
- The user at the Mobile Device Server should have the tty requirement disabled. Also, if you plan to use USB and serial support with Avalanche, the user at the Mobile Device Server must have appropriate permissions.
- Sufficiently high limit on open files. Refer to *Increasing the Open Files Limit* on page 14 for information about allowing more files to be open.
- Tomcat 7.0.x installed at the location you plan to install the Enterprise server.
- Installed DBMS (PostgreSQL 9.0 or Oracle 11g). See the Before You Begin sections for information on how to set these up.
  - Before You Begin (PostgreSQL)
Before You Begin (Oracle)

Before You Begin (PostgreSQL)

You must complete the following tasks before you can install Avalanche to work with PostgreSQL databases:

- Install PostgreSQL 9.0.
- Create the Avalanche databases. The databases must be named **avalanche52** and **avastats52**.
- Create the login role for the databases.
- If you are installing the Enterprise Server in a different location than the database server, modify **pg_hba.conf** and **postgresql.conf** to support a remote connection.

Before You Begin (Oracle)

You must complete the following tasks before you can install Avalanche with Oracle:

- Install Oracle 11g and obtain DBMS licenses.
- Perform an Administrator installation of the Oracle Client Utility (win32_11gR1_client.zip) at the location where you will be installing the Enterprise Server.

**NOTE** If you do not use the Administrator installation type, Avalanche will not have all the tools necessary to communicate with the databases.

- Create or determine the SID Avalanche will use.
- Create the Avalanche schemas (i.e., usernames and passwords). For Avalanche 5.2, Wavelink recommends the schema names **avalanche52** and **avastats52**. The schemas will need sufficient privileges to create, alter, drop, select, delete, or update any table, index, view, or sequence.
- Update the **tsanames.ora** file to contain the configuration information for the chosen SID. The file should be available to the Client Utility.
- If you are installing the Enterprise Server in a different location than the database server, configure the server to allow remote access.

## Installing with RPM Files

The preferred method of installing Avalanche services uses RPM files. When you install using an RPM, it creates the directories for the files and adds the services to the Service Manager.

**NOTE** You also have the option to install using tar files. Create directories for the tar files, and then extract the files to the proper directories. For information on installing with tar files, see *Installing with tar Files* on page 22.

Wavelink recommends installing the following files at the Enterprise Server location: Enterprise Server, License Server, Statistics Server, InfoRail service, and the Tomcat WAR files.

Wavelink recommends installing the Mobile Device Server and Service Manager together using the Java Console to deploy the server. For information on deploying a server, see *Deploying a Mobile Device Server* on page 16.

You also have the option to install them using RPMs or tar files. If you install using RPMs or tar files, you must configure the servers’ properties files before starting the services. For information on configuring the properties files, see *Configuring the Mobile Device Server after Manual Installation* on page 27.

**To install using RPM files:**

1. Obtain the files from Wavelink.

2. From a shell, type:

   ```bash
   rpm -i [filename].rpm
   ```

   where `[filename]` is the name of the RPM file you want to install. Repeat this task for all the RPM files you want to install locally.
Chapter 1: Installing Avalanche

Populating the Databases

After you have created the databases, they need to be populated with Avalanche setup information. The scripts used to populate the databases are included in the Enterprise Server and Statistics Server installation.

If you have the Enterprise Server, Statistics Server, and PostgreSQL databases all on the same machine, running the `db_setup.sh` script will run all the scripts in order.

If you are using Oracle databases, or if PostgreSQL is installed on a different machine than the Enterprise and Statistics Servers, you may need to copy the files from the server installation location to the computer where the databases are. After installing the Enterprise and Statistics Servers, the four Enterprise Server scripts will be in the `eserver/db/Oracle` directory (if you are working with Oracle) or the `eserver/db/Postgres` directory if you are working with PostgreSQL:

- `avalanche.sql`
- `amc_en_US_INSERT_DEFAULT.sql`
- `quartz.sql`
- `amc_en_US_CREATE_HB_SEQ.sql`

And the three Statistics Server scripts will be in the `statserver/db/Oracle` directory:

- `avastats.sql`
- `stat_en_US_INSERT_DEFAULT.sql`
- `stat_en_US_CREATE_HB_SEQ.sql`

The scripts are run from a command line if you are using PostgreSQL or from the Oracle SQL Developer if you are using Oracle.

To populate local PostgreSQL databases:

1. Navigate to `/opt/wavelink/eserver/db`
2. Open the `db_setup.sh` script and find the following section:

```bash
export DBNAME=avalanche52;
export PGUSER=postgres;
export PGPASS=admin23
export PGPASSWORD=$PGPASS
export DBHOST=127.0.0.1;
export DBPORT=5432;
```
3 Change the DBNAME, PGUSER, PGPASS, DBHOST, and DBPORT values to the database name, username, password, host address, and port for your Enterprise Server database. Save your changes.

4 From the eserver directory, type sudo db/db_setup.sh to run the script that populates the Enterprise Server database.

5 Navigate to /opt/wavelink/statserver/db

6 Open the db_setup.sh script and find the following section:

   export DBNAME=avalanche52;
   export PGUSER=postgres;
   export PGPASS=admin23
   export PGPASSWORD=$PGPASS
   export DBHOST=127.0.0.1;
   export DBPORT=5432;

7 Change the DBNAME, PGUSER, PGPASS, DBHOST, and DBPORT values to the database name, username, password, host address, and port for your Statistics Server database. Save your changes.

8 From the statserver directory, type sudo db/db_setup.sh to run the script that populates the Statistics Server database.

To populate remote PostgreSQL databases:

1 Copy the seven scripts files to the PostgreSQL bin directory.

2 Use the following commands from a command line to run the scripts in order, replacing [path] with the path to the script:

   psql.exe -U postgres -d avalanche52 -f [path]\avalanche.sql
   psql.exe -U postgres -d avalanche52 -f [path]\amc_en_US_INSERT_DEFAULT.sql
   psql.exe -U postgres -d avalanche52 -f [path]\quartz.sql
   psql.exe -U postgres -d avalanche52 -f [path]\amc_en_US_CREATE_HB_SEQ.sql
   psql.exe -U postgres -d avastats 52 -f [path]\avastats.sql
   psql.exe -U postgres -d avastats 52 -f [path]\stat_en_US_INSERT_DEFAULT.sql
   psql.exe -U postgres -d avastats 52 -f [path]\stat_en_US_CREATE_HB_SEQ.sql

3 Navigate to /opt/wavelink/eserver/db
4 Open the `db_setup.sh` script and find the following section:

```
export DBNAME=avalanche52;
export PGUSER=postgres;
export PGPASS=admin23
export PGPASSWORD=$PGPASS
export DBHOST=127.0.0.1;
export DBPORT=5432;
```

5 Change the `DBNAME`, `PGUSER`, `PGPASS`, `DBHOST`, and `DBPORT` values to the database name, username, password, host address, and port for your Enterprise Server database.

6 Delete the following section:

```
# Make an honest attempt to add the postgres installation directory
to the path. Unfortunately, this is not going to work for all
distros.

if [ -e /opt/PostgreSQL/9.0/bin/psql ]; then
  PATH=$PATH:/opt/PostgreSQL/9.0/bin
fi
if [ -e /opt/PostgreSQL/8.4/bin/psql ]; then
  PATH=$PATH:/opt/PostgreSQL/8.4/bin
fi
if [ -e /opt/PostgreSQL/8.3/bin/psql ]; then
  PATH=$PATH:/opt/PostgreSQL/8.3/bin
fi
```

```
echo "Initializing $SCRIPTPATH database"
dropdb -h $DBHOST $DBNAME
createdb -h $DBHOST $DBNAME
psql -q -h $DBHOST -d $DBNAME -f ./db/$SCRIPTPATH/amc_en_US_CREATE_HB_SEQ.sql
psql -q -h $DBHOST -d $DBNAME -f ./db/$SCRIPTPATH/avalanche.sql
psql -q -h $DBHOST -d $DBNAME -f ./db/$SCRIPTPATH/quartz.sql
psql -q -h $DBHOST -d $DBNAME -f ./db/$SCRIPTPATH/amc_en_US_INSERT_DEFAULT.sql
```

7 Save your changes.

8 From the `eserver` directory, type `sudo db/db_setup.sh`

9 Navigate to `/opt/wavelink/statserver/db`

10 Repeat steps 4 through 7 for the script.

11 From the `statserver` directory, type `sudo db/db_setup.sh`
To populate the Oracle databases:

1. If the Enterprise Server, Statistics Server, and database are on different computers, copy the scripts from the Enterprise Server and Statistics Server to the computer where the database is.

2. Open the Oracle SQL Developer.

3. Click File > Open and browse to the avalanche.sql script.

4. Click Run Script.

5. Repeat steps 3 and 4 for the other six scripts in order.

6. Navigate to /opt/wavelink/eserver/db

7. Open the db_setup.sh script and find the following section:

   ```
   export DBNAME=avalanche52;
   export PGUSER=postgres;
   export PGPASS=admin23
   export PGPASSWORD=$PGPASS
   export DBHOST=127.0.0.1;
   export DBPORT=5432;
   ```

8. Change the DBNAME, PGUSER, PGPASS, DBHOST, and DBPORT values to the database name, username, password, host address, and port for your Enterprise Server database.

9. Delete the following section:

   ```
   # Make an honest attempt to add the postgres installation directory to
   # the path. Unfortunately, this is not going to work for all
   # distros.
   if [ -e /opt/PostgreSQL/9.0/bin/psql ]; then
     PATH=$PATH:/opt/PostgreSQL/9.0/bin
   fi
   if [ -e /opt/PostgreSQL/8.4/bin/psql ]; then
     PATH=$PATH:/opt/PostgreSQL/8.4/bin
   fi
   if [ -e /opt/PostgreSQL/8.3/bin/psql ]; then
     PATH=$PATH:/opt/PostgreSQL/8.3/bin
   fi
   ```

   ```
   echo "Initializing $SCRIPTPATH database"
   dropdb -h $DBHOST $DBNAME
   createdb -h $DBHOST $DBNAME
   psql -q -h $DBHOST -d $DBNAME -f ./db/$SCRIPTPATH/
   amc_en_US_CREATE_HB_SEQ.sql
   ```
Chapter 1: Installing Avalanche

10 Find the following section:

LDRCP=./lib/AvalancheImages.jar:./lib/enterpriseserver.jar:./lib/postgresql-8.4-701.jdbc4.jar:./lib/xstream-1.4-SNAPSHOT.jar:./lib/xpp3_min-1.1.4c.jar:./lib/commons-codec-1.3.jar:./lib/xmlpull-1.1.3.jar

java -cp $LDRCP com.wavelink.avalanche.images.ImageLoader postgres $DBHOST $DBPORT $PGUSER $PGPASS $DBNAME

11 Change postgresql-8.4-701.jdbc4.jar to ojdbc6.jar and change postgres to oracle.

12 Save your changes.

13 From the eserver directory, type sudo db/db_setup.sh

14 Navigate to /opt/wavelink/statserver/db

15 Repeat steps 7 through 12 for the script.

16 From the statserver directory, type sudo db/db_setup.sh

Configuring the Database and Tomcat Files

In order for the Enterprise Server, Statistics Server, and Web Console to communicate with the databases, some files need to be configured with the database information while the servers are not running.

These files are in the eserver/conf/main directory. Once you have modified the files for the Enterprise Server, copy them to the directories for the Statistics Server and Tomcat.

To modify these files, you must know the address of the database computer, the port the databases are using, the database names, username, and password.

To configure the dao and quartz properties files for PostgreSQL:

1 On the computer where you installed the Enterprise Server, navigate to the eserver/conf/main directory and open the dao-factory.xml file with a text editor.
2 Near the beginning of the file, locate the section with the following properties:

```xml
<property name="url" value="jdbc:postgresql://localhost:5432/avalanche52"/>
<property name="username" value="postgres"/>
<property name="password" value="Admin!23"/>
```

3 Change the computer address (localhost), port (5432), Enterprise Server database name (avalanche52), username (postgres), and password (Admin!23) values to the values for the Enterprise Server.

4 Save and close the file.

5 Open `dao-factory-ss-es.xml` and repeat steps 2 through 4.

6 Open `dao-factory-ss.xml` and repeat steps 2 through 4, replacing the default values with the values for the Statistics Server.

7 Open `quartz.avaserver.properties` and locate the lines at the end with the following properties:

```properties
org.quartz.dataSource.mme.URL = jdbc:postgresql://localhost:5432/avalanche52
org.quartz.dataSource.mme.user = postgres
org.quartz.dataSource.mme.password = Admin!23
```

8 Change the computer address (localhost), port (5432), Enterprise Server database name (avalanche52), username (postgres), and password (Admin!23) values to the values for the Enterprise Server.

9 Save and close the file.

10 Copy the `dao-factory.xml`, `dao-factory-ss.xml`, and `dao-factory-ss-es.xml` files to the computer where the Statistics Server is installed and put them in the `statserver/conf/main` directory. This will overwrite the existing files with the same names.

11 Copy the `dao-factory.xml`, `dao-factory-ss.xml`, and `dao-factory-ss-es.xml` files to the computer where Tomcat is installed and put them in the Tomcat `lib` directory.
To configure the dao and quartz properties files for Oracle:

1. On the computer where you installed the Enterprise Server, navigate to the eserver/conf/main directory and open the dao-factory.xml file with a text editor.

2. Near the beginning of the file, locate the section with the following properties:

   ```xml
   <property name="driverClassName" value="org.postgresql.Driver"/>
   <property name="url" value="jdbc:postgresql://localhost:5432/avalanche52"/>
   <property name="username" value="postgres"/>
   <property name="password" value="Admin!23"/>
   ```


4. Change the URL value to `jdbc:oracle:thin:@[hostname]:[port]:[dbname or SID]` where `[hostname]`, `[port]`, and `[dbname or SID]` are the address, port, and name of the Enterprise Server database.

5. Change the username (postgres), and password (Admin!23) values to match the username and password for the Enterprise Server database.

6. Locate the following line in the file:

   ```xml
   <prop key="hibernate.dialect">org.hibernate.dialect.PostgreSQLDialect</prop>
   ```

7. Change `PostgreSQLDialect` to `Oracle10gDialect`.

8. Save and close the file.


10. Open dao-factory-ss.xml and repeat steps 2 through 8, replacing the default values with the values for the Statistics Server.

11. Open quartz.avaserver.properties and locate the lines at the end of the file with the following properties:

    ```properties
    org.quartz.jobStore.driverDelegateClass = org.quartz.impl.jdbcjobstore.PostgreSQLDelegate
    ```
org.quartz.dataSource.mme.driver = org.postgresql.Driver
org.quartz.dataSource.mme.URL = jdbc:postgresql://localhost:5432/avalanche52
org.quartz.dataSource.mme.user = postgres
org.quartz.dataSource.mme.password = Admin!23

12 Change PostgreSQLDelegate to oracle.OracleDelegate

13 Change org.postgresql.Driver to oracle.jdbc.driver.OracleDriver

14 Change the URL for the database to
   jdbc:oracle:thin:@[address]:[port]:[database name or SID]

15 Change the username (postgres), and password (Admin!23) values to the
   username and password for your databases.

16 Save and close the file.

17 Copy the dao-factory.xml, dao-factory-ss.xml, and
   dao-factory-ss-es.xml files to the computer where the Statistics Server is
   installed and put them in the statserver/conf/main directory. This will
   overwrite the existing files with the same names.

18 Copy the dao-factory.xml, dao-factory-ss.xml, and
   dao-factory-ss-es.xml files to the computer where Tomcat is installed and
   put them in the Tomcat lib directory.

Extracting the WAR File for Tomcat

In order to use the Web Console with Avalanche, you must have Tomcat installed on
the same box as the Enterprise Server. You must have the Enterprise Server installed
in order to have the WAR file.

To extract the WAR file for Tomcat:

1 Ensure that the Tomcat service is not running.

2 Copy the WAR file (included in the Enterprise Server installation zip file) to the
tomcat/webapps directory and extract it.
Starting the Services

Once the files are installed and configured, start the services. The following method uses a command line, or you can use another method if you prefer. You will need to start the Enterprise Server, Statistics Server, License Server, and InfoRail. Tomcat should also be started up after the other services.

**NOTE** If you deploy the Mobile Device Server from the Avalanche Console, you do not need to manually start the service.

To start the services from a command line:
1. Use the following commands:
   
   ```
   Sudo /etc/init.d/wl-inforail start
   Sudo /etc/init.d/wl-eserver start
   Sudo /etc/init.d/wl-licserver start
   Sudo /etc/init.d/wl-statserver start
   ```
2. Navigate to the `tomcat/bin` directory and use the following command to start Tomcat:
   
   ```
   Sudo ./startup.sh
   ```

Increasing the Open Files Limit

If the InfoRail server is run under a user account whose per-process limit on open files is too low, the log file returns entries with errors. New subscribers will not be able to connect to the router. To raise the number of open connections or files, the per-process limit needs to be increased. The limit can be increased temporarily using the `ulimit` command before executing the router or permanently by increasing the limit for the account or the whole system.

You may also receive error messages if the overall number of open files for the entire system has been exceeded. You can check the configured limit for open files and then increase the overall number of open files for the system.

**To temporarily increase:**

1. Insert this command into the script that starts the router:
   
   ```
   ulimit -n <new limit>
   ```
2 Log out of the system and then log back in for the changes to take effect.

To permanently increase:
1 Add the following lines to the etc/security/limits.conf file:

   <account> soft nofile <softlimit>
   <account> hard nofile <hardlimit>

   The account field can be in various forms such as group names and wild cards.

2 Log out of the system and then log back in for the changes to take effect.

3 Modify the startup scripts for each of the device servers that need increased open file limits.

To check the configured limit:
- From a shell, enter the following command:

   cat /proc/sys/fs/file-max

   This command reports three values. The first value is the total allocated file openings. The second value is the total free allocated file openings. The third value is the maximum open files allowed.

To increase the file-max value
1 Navigate to /etc/sysctl.conf and add the following line:

   fs.file-max = <new limit>

2 Reboot the system.
Chapter 2: Deploying a Mobile Device Server

If you want to run a Mobile Device Server on a Linux OS, you can create a deployment package using RPMs and deploy it to the server location from the Avalanche Console. This section includes the following information:

- Creating a Server Location
- Importing the RPM Files
- Building an RPM Deployment Package
- Configuring Serial and USB Support

**NOTE** Currently, there is no support for an Infrastructure Server on a Linux OS.

After you build the deployment package, use the Avalanche Task Scheduler to deploy the package. You must have the firewall configured to allow Avalanche traffic in order for the deployment to be successful.

Creating a Server Location

You must create a server location in the Avalanche Console before you deploy the RPM package for a mobile device server. For information on creating a server location, see the Avalanche User Guide.

**NOTE** Ensure you know the root user for the user name and password when you create a server location.

Importing the RPM Files

Before you can build your deployment package you must import the RPM files you want to include. You need to obtain the RPM files from Wavelink.

To import:

1. From the Java Console, select **File > Import > Linux Server RPMs**.

   The *Import Linux Server RPMs* dialog box appears.
2 Click **Select RPMs for Import** and browse to the location of the RPMs you want to import.

3 Once you have added file you want to import, click **Import Selected RPMs**.

**NOTE** You cannot select more than one RPM at a time for this step. To add more RPMs, repeat steps 2 and 3.

The imported RPMs will be available when you build your deployment package.

4 Click **Done** to close the dialog box.

### Building an RPM Deployment Package

Once you have imported the RPM files and created the Server Location to which you are sending the files, you can build a deployment package.

**To create a deployment package for a Mobile Device Server:**

1 From the Java Console, click **Tools > Deployment Packages**.

   The **Deployment Package Manager** dialog box appears.

2 Click **Add**.

   The **New Package Wizard** appears.

3 Select the **Create a Distributed Server Package** option and click **Next**.

   The Select Server Type screen appears.

4 Select the **Linux Agent RPMs** option and click **Next**.

   The Enterprise Server Location screen appears.

5 Type the IP address of the Enterprise Server in the **Enterprise Server Site Address** text box. This will allow the Mobile Device Server to contact the Enterprise Server. Click **Next**.

   The Select Linux Agent RPMs screen appears.

6 From the list box, select the RPM files you want to include in your deployment package and click **Next**.
Chapter 2: Deploying a Mobile Device Server

The Enter Package Name screen appears.

Type a unique **Package Name** and click **Next**.

Avalanche creates the deployment package. When it is finished, the Package Complete screen appears.

7 Click **Finish** to return to the *Deployment Package Manager* dialog box.

8 Click **Close** to return to the Avalanche Console.

To deploy the Server package, you must use the Task Scheduler and perform a Deploy/Update Server task. For information on using the Task Scheduler, see the Avalanche Java Console User Guide.

**Configuring Serial and USB Support**

Mobile devices may communicate with the Mobile Device Server via a serial or a USB connection. The Linux user account that is running the Mobile Device Server must have the appropriate permissions in order for USB and serial support to work.

**NOTE** USB connections are only available if you have a Linux kernel 2.6.9 or newer. The manufacturers and device codes supported through the USB serial interface can be found in the source code for the ipac driver (usually `/usr/src/linux/drivers/usb/serial/ipac.c`).

The mobile device, Enabler, and the Mobile Device Server must be configured to enable serial communication. To enable serial communication on your mobile device, refer to the specific user manual for that device. You can configure the Mobile Device Server for serial connections through the Avalanche Java Console. The Enabler can be configured with the Enabler config utility or from the Enabler interface.

To configure the server for serial connections:

1 From the Java Console, select the **Profiles** tab.

2 Select the Mobile Device Server profile that you want to configure.

3 In the **Server Resources** area, type the serial port(s) you want reserved for Avalanche use in the Reserved Serial Ports text box.

4 Save your changes.
5 Deploy the updated profile to the server(s).

Serial communication is now enabled for the servers using the profile.

To configure the Enabler to communicate over a USB/serial connection:
1 Access the **Connection** tab for the Enabler configuration.
2 Enable the **Check serial connection** and **Disable ActiveSync** check boxes.

The mobile device will now be able to connect via USB or a serial connection.

To connect a device to the Linux Mobile Device Server over a USB/serial connection:
1 Ensure that the Enabler is configured correctly.
2 Connect the device to the Mobile Device Server system with the proper cable.
3 From the mobile device, force a connection to the Mobile Device Server by tapping **File > Connect**.

The mobile device will indicate that it has established a connection with the Mobile Device Server and will download any required updates.
Chapter 3: Using the Package Converter

The Avalanche Package Converter allows you to take older .ava files and convert them into a format that is compatible with Linux. The package converter is for use with old Wavelink .ava files and Avalanche packages created by other vendors.

Requirements

The Avalanche Package Converter requires Java JRE or JDK version 1.3.1_03 or above to run. The Java executable should be in the search path.

The Package Converter also needs some temporary disk space for its operation. The program uses the system temporary directory defined with the TMP environment variable for that purpose. If necessary, you can set the TMP variable before running the program.

Converting Packages

The Package Converter is included in the Avalanche Console Only installation. It is a .zip file located in the Avalanche installation directory. The default location is C:\Program Files\Wavelink\Avalanche Console. The .zip file contains the following files:

- runit.bat. A Windows batch file that runs the Converter.
- readme.txt. The text file that provides information about the Package Converter.
- PackageConverter.jar. The Package Converter code.

For the purpose of this section, the input package refers to the original package that you are converting. The output package refers to the converted package.

To convert a package:
1. Locate the PackageConverter.zip file in the Avalanche installation directory.
2. Unzip the file into a directory of your choice.
3. Place all .ava packages that you are going to convert in this same directory.
4. Open a command prompt.
5. Navigate to the location of the Package Converter.

6. Use the following command to convert packages:

   `runit <options> <Input Package> <Output Package>`

7. The package is converted and placed in the same directory.

The following is a list of options you can use to manipulate the Package Converter:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-k</code></td>
<td>Builds a synthetic CTT file from the PPF.</td>
</tr>
<tr>
<td><code>-h</code></td>
<td>Displays the help page.</td>
</tr>
<tr>
<td><code>-m</code></td>
<td>An optional version 3 main executable.</td>
</tr>
<tr>
<td><code>-n</code></td>
<td>Forces the Package Converter to run strictly as a version 2 package to version 3 package converter.</td>
</tr>
<tr>
<td><code>-r &quot;&lt;new package name&gt;&quot;</code></td>
<td>Allows you to rename the output package.</td>
</tr>
<tr>
<td><code>-s &quot;&lt;vendor name&gt;&quot;</code></td>
<td>Changes the vendor name from Wavelink Corporation to a specified name.</td>
</tr>
<tr>
<td><code>-v</code></td>
<td>Runs the Package Converter in verbose mode.</td>
</tr>
</tbody>
</table>
Appendix A: Installing with tar Files

As an alternative to RPM files, you have the option to install Avalanche using tar files. Wavelink recommends installing the following files at the Enterprise Server location: Enterprise Server, License Server, Statistics Server, InfoRail service, and the Tomcat WAR files.

Wavelink also recommends installing the Mobile Device Server and Service Manager together.

When you install using tar files, the user must have permissions to create the directories, install, and execute scripts in order to start the services. Complete the following steps:

- Creating Server Directories
- Installing the Servers
- Configuring the Databases and Tomcat
- Starting the Servers
- Configuring the Mobile Device Server after Manual Installation
- Managing the Mobile Device Server from the Console

Creating Server Directories

You must create directories for the components you before can install.

To create Wavelink directories:

1. Log in as root.
2. Create the following directories:
   - /opt/wavelink
   - /var/opt/wavelink

   You will install the Enterprise Server, Mobile Device Server and InfoRail tar files to these directories.
3. Change the owner of both directories to a non-root user.
Log out.

Log in again as the non-root user.

**Installing the Servers**

To install the servers with tar files, create the necessary directories and extract the files to the directories. This section contains information on the following servers:

- Installing the Enterprise Server
- Installing the Statistics Server
- Installing the InfoRail Service
- Installing the License Server
- Installing the Mobile Device Server
- Installing the Service Manager

**Installing the Enterprise Server**

The Enterprise Server manages mobile devices and infrastructure devices. You can install the Enterprise Server on a Linux machine, but it must be managed through either the Java Console or the Web Console. (The Java Console must be installed on a computer running a Windows OS. The Web Console is accessed using a web browser.)

To install the Enterprise Server

1. Create both the following directories:
   - `/opt/wavelink/eserver`
   - `/var/opt/wavelink/eserver`

2. Extract the eserver file to the `/var/opt/wavelink/eserver` directory.

   Once you extract the tar files, initialize the database before you start the servers.

**Installing the Statistics Server**

The Statistics Server manages device information and statistics. Extract the Statistics Server files to the appropriate directories.
To install the Statistics Server:
1 Create both the following directories:
   • /opt/wavelink/statserver
   • /var/opt/wavelink/statserver
2 Extract the Statistics Server files to the /opt/wavelink/statserver directory.

Installing the InfoRail Service

When you install the InfoRail service on Linux, you extract the tar file to the appropriate directories.

To install InfoRail:
1 Create both the following InfoRail directories:
   • /opt/wavelink/inforail
   • /var/opt/wavelink/inforail
2 Extract the tar file to the /opt/wavelink/inforail directory.

Installing the License Server

Extract the License Server files to the appropriate directories.

To install the License Server:
1 Create both the following License Server directories:
   • /opt/wavelink/licenseserver
   • /var/opt/wavelink/licenseserver
2 Extract the License Server tar file to the /opt/wavelink/inforail directory.

Installing the Mobile Device Server

The Mobile Device Server manages your mobile devices.

To install the Mobile Device Server:
1 Create both the following Mobile Device Server directories:
Appendix A: Installing with tar Files

1. Create both the following directories:
   - `/opt/wavelink/servicemanager`
   - `/var/opt/wavelink/servicemanager`

2. Extract the Mobile Device Server tar file to the `/opt/wavelink/avalanche` directory.

### Installing the Service Manager

The Service Manager allows you to start and stop the Mobile Device Server from the Avalanche Console. It should be installed on the same computer as the Mobile Device Server.

**To install the Service Manager:**

1. Create both the following directories:
   - `/opt/wavelink/servicemanager`
   - `/var/opt/wavelink/servicemanager`

2. Extract the Service Manager tar file to the `/opt/wavelink/servicemanager` directory.

### Configuring the Databases and Tomcat

You must populate the databases, configure them, and extract the WAR file for Tomcat while the services are stopped. For instructions on these steps, see:

- *Populating the Databases* on page 6
- *Configuring the Database and Tomcat Files* on page 10
- *Extracting the WAR File for Tomcat* on page 13

### Starting the Servers

Once you extract the server files, set user permissions and set up the database, you can start the Enterprise Server, Mobile Device Server, License Server and InfoRail service.
To start the Enterprise Server:
1. Open a shell and navigate to /var/opt/wavelink/eserver
2. Type ./eserver_alt.sh

To start the InfoRail service:
1. Open a shell and navigate to /opt/wavelink/inforail.
2. Type ./WLInfoRail

**NOTE** To run as a daemon, use the `-d` option.

The InfoRail service starts running on the system.

To start the License Server:
1. Open a shell and navigate to /opt/wavelink/licenseserver
2. Type ./WLLicenseservice

**NOTE** To run as a daemon, use the `-d` option.

To start the Statistics Server:
1. Open a shell and navigate to /opt/wavelink/statserver
2. Type ./statserver.sh

To start the Mobile Device Server:
1. Open a shell and navigate to /opt/wavelink/avalanche
2. Type ./WL Avalanche

**NOTE** To run as a daemon, use the `-d` option.

To start the Service Manager:
1. Open a shell and navigate to /opt/wavelink/servicemanager
2. Type ./WLAmcServiceManager
Configuring the Mobile Device Server after Manual Installation

If you installed the Mobile Device Server locally (using RPMs or tar files) rather than using the Avalanche Console to deploy a server package, you must configure the properties files with the IP addresses for the InfoRail and License Server before the Mobile Device Server will function properly. You can configure the properties files using a script, or modify the files directly.

- Configuring with editconfig.pl
- Or-

Configuring the Properties Files

Configuring with editconfig.pl

To configure the Mobile Device Server to connect to the Enterprise Server and License Server, configure the Avalanche.properties file and the servicemanager.properties file by using a Perl script.

The script allows you to configure the IP address for InfoRail and the License Server, as well as the Mobile Device Server log level and the site identifier. The default log level is INFO. The site identifier is a unique string that identifies the server. Providing a site identifier is optional, and you should not modify the site identifier after the Mobile Device Server has contacted the Enterprise Server.

To configure using editconfig.pl:

1. Navigate to opt/wavelink/avalanche and type:
   
   ```
   sudo ./editconfig.pl
   ```

2. At the prompts, type the IP address for InfoRail, the site identifier, the log level for the server, and the License Server address.

3. At the prompt, review your changes and press Y to apply them. The script will modify the properties files.

4. Restart the Mobile Device Server and Service Manager.

Configuring the Properties Files

To configure the Mobile Device Server to connect to the Enterprise Server and License Server, configure the Avalanche.properties file. The address can be an IP address or a DNS name.
The Service Manager allows you to start and stop the Mobile Device Server from the Avalanche Console. In order for the Service Manager to function properly, the servicemanager.properties file must be configured.

To configure the properties files:

1. Stop the Mobile Device Server and Service Manager.

2. In the wavelink/avalanche directory, open the file named Avalanche.properties and use a text editor to add the following properties to the file:

   InfoRail.Server=[address of the Enterprise Server]
   Licenseserver=[address of the License Server]

   For example:

   InfoRail.Server=62.4.56.3
   Licenseserver=62.4.56.3

3. Save and close Avalanche.properties.

4. Restart the Mobile Device Server.

The server will now connect to the Enterprise Server and the License Server. After the server has connected, the SiteIdentifier value will be populated.

5. Stop the Mobile Device Server.

6. Navigate to the wavelink/avalanche directory and open Avalanche.properties with a text editor.

7. Find the SiteIdentifier property and copy this property and its value.

8. Navigate to the wavelink/servicemanager directory and open servicemanager.properties with a text editor.

9. Paste the SiteIdentifier property and value into this file and save it.

10. Restart the Service Manager and Mobile Device Server.

Managing the Mobile Device Server from the Console

Once the Mobile Device Server is installed, configured, and has contacted the Enterprise Server, it appears in the Unassigned Server Locations folder of the Avalanche Console. The server location can be identified by the IP address of the
Linux host. You can then move the server location to a region and rename, configure, and manage it. The Mobile Device Server will not accept connections from mobile devices until it is assigned to a region.

**NOTE** If the Mobile Device Server does not appear in the Avalanche Console, check to make sure the information in the *Avalanche.properties* file is correct.

Some older software packages may not install properly on a Linux host because of file path case sensitivity. If a package installs correctly in Avalanche but is not distributed to a Mobile Device Server (possibly resulting in a software installation failure alarm), retrieve the *Avalanche.log* file from the Linux host and inspect it for package installation errors. Wavelink Customer Support can help with the proper formatting of older or custom-built packages that may fail due to case-sensitive paths.
Appendix B: Wavelink Contact Information

If you have comments or questions regarding this product, please contact Wavelink Customer Service.

E-mail Wavelink Customer Support at: CustomerService@wavelink.com

For customers within North America and Canada, call the Wavelink Technical Support line at 801-316-9000 (option 2) or 888-699-9283.

For international customers, call the international Wavelink Technical Support line at +800 9283 5465.

For Europe, Middle East, and Africa, hours are 9 AM - 5 PM GMT.

For all other customers, hours are 7 AM - 7 PM MST.